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Brenda'’s Bagels Lab 4

Case Study Using Microsoft Dynamics GP

Brenda’s Bagels

LAB 4: Transaction Processing
Background

Congratulations! You are ready to book some transactions! We are going to have to
book all the activity for July as well as enter vendor invoices and bill customers.
Then it’s going to be time to enter payroll into the GL. This is the real fun!

Assignment

This lab contains four parts to be completed as follows:

Lab 4.1 Transactions

Lab 4.2 Vendor Invoices
Lab 4.3 Customer Invoices
Lab 4.4 Payroll
Deliverables

As you complete each part of the assignment in Microsoft Dynamics, you will be
required to take a screenshot and paste it into one Microsoft Word document. For
this assignment, there are three screenshots:

1. Transactions (Lab 4.1)

2. Vendor Invoices (Lab 4.2)
3. Customer Invoices (Lab 4.3)
4. Payroll (Lab 4.4)

Reference Documents:
1. Microsoft Dynamics Payables Management
2. Microsoft Dynamics Receivables Management
3. Microsoft Dynamics General Ledger
4. Microsoft Dynamics Fixed Assets

Please proceed to Lab #4 below!
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Lab 4.1 Transactions

Lab 4.1.1 Set up the business bank account

Click on Microsoft Dynamics GP>Tools>Setup>Company>Bank

@@v [ Home » =R =
ome
[ 4 Microsoft Dynamics GP ~| Transactions ~ Inquiry ~ Reports « Cards ~
[ User and Company ome Customize this page... New Ror
User Date >
§ ﬁ Connect om -~ Y
Edit ‘ New Task.. | | Signin | —
Setup Checklt . &0
Maintenance » Utilities > System 4
SmartList Routines » Company
Reminders SmartList Builder 4 Posting Account Format
Task List Customize » Workflow for Sharepoint Fiscal Periods
Process Monitor Integrate b Financial 4 Tax Details
Report Processing Status Macro > Sales » Tax Schedules
User Preferences Resource Descriptions b Purchasing » Shipping Methods n
Print Setup... Analysis Cubes =iy ' Paymentiieams
Print... Ctrl+P P’yfg" >
N Project 4 Credit Cards
Close All Windows
Human Resources > Comments
= e —— - t
Xt ks Fixed Assets > Internet Information
Add Reports Field Service , Custom Link L
- ]
Analysis Cubes » E-mail Settings
Online Services > E-mail Message Setup "
Crente Busnass Document Attachment Setup l,
Process Server Setup Customer/Vendor Setup 1
Activity Tracking Setup Workflow v b
i ¢
;g;m;:z:am Advanced Lookups
Payment Document Setup
Reverse Charge VAT Setup
Modelo 347 Tax Detail
Modelo 347 Cash Account
@ — Analytical Accounting >
Grant Management
3= Financial |
Save Clear Delete File Print| Tools Help Add
LA % ¥  Note
Actions File Tools Help
Bank ID BeT 20|
Name Boulder Bank and Trust
Address 438 Main Street Phone 1 (303) 555-6768 Ext. 1000]
Phone 2
Phone 3
City Boulder Fax
State co
ZIP Code 80301
Country usa
Transit Number DD Transit Number
Bank Branch
[l > » [pyBarkiD v
|

Enter the information as above and click Save. Close the window.
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Lab 4.1.2 Book July Transactions
First, let’s change the date in our system. DON'T SKIP THIS STEP!

Click Microsoft Dynamics GP>User Date

[ _ 4 Microsoft Dynamics GP .]

. User and Company
| User Date

Edit »
Tools >
Maintenance >

| SmartList

| Reminders

: Task List

Process Monitor
Report Processing Status

User Preferences

Print Setup...
Print... Ctrl+P

! Close All Windows
| e

OX = 1| ©.

OK  Cancel File  Tools Help

v v

Actions File Tools Help

@l » I | Wednesday

Change the date to July 31, 2015 and click OK
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Now, let’s book some transactions!

Click Transactions>Financial>General

Lab 4

Home »

QO- |

[4] £

[ Home | Stude
User Preferences
b Shortcuts Reminde
b Report Shortcuts
Tasks
Startup
Custom

Sales

Purchasing
Payroll
Fixed Assets

Returns Management

A Microsoft Dynamics GP ~ [Tr_a_nsactions v] Inquiry ~ Reports v Cards ~

General

4 Clearing

4 Quick Journal
4 Batches

4 Series Post

’ Bank Deposits

<

Check forrayrommxop

Bank Transactions

|+

Miscellaneous Check

Bank Transfers

Reconcile Bank Statement

Transaction Matching
Transaction Matching Groups

Enter the transaction as it is below (notice there’s no Batch ID) and then click Post.

Notice that the Transa%n Date is the date that we set the system to.

= X ¢

Actions

Il @7

Journal Entry

1 PD I Intercompany

Transaction Type:

Transaction Date

File Print Tools Help Add
i i ¥ Note
File Tools Help
Batc&iI | 2]

7/31/2015

Reversing Date I

® Standard ¢ Reversing |

Source Document GJ P

Reference Capital Contribution ]
Currency ID Lr I" \D|

Co.I0 [~ 7 [Account [=-17 [ 9]» Debit Credit &

Description @

Distribution Reference Corresp Co. ID f

BE1 000-1100-00 $25,000.00 $0.00 4

BE1 000-3100-00 $0.00
Total $25,000.00 $25,000.00

Difference $0.00
14 4 » M [byBachiD - Status

Close the window.
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Close the window. Print it if you wish or hit Cancel. Let’s see if our entry is there!
Click Inquiry>Financial>Summary

_ & Microsoft Dynamics GP _[of x|
QQ' | Home » I"I E @

4 Microsoft Dynamics GP ~  Transactions ~ [ Inquiry v] Reports ~ Cards ~

’ System »
Homa || Studentt’s Home s
User Preferences m To Do Company *
b Shortcuts Reminders
I Report Shortcuts Sales 4 Detail
Tasks . .
Startup . Purchasing ’ Analysis
Customer rience Imps Human Resources » Account Rollup
Check for Payroll tax updat . .
. Fixed Assets » Journal Entry Inquiry
—Ii Returns Management » History Summary

Enter in the cash account by entering it in if you remember it or clicking the lookup:

9 £ ./ fr l [ *
£ 2 I © .:l
Clear  View File Print Tools Help Add
2 N S ¥ Note
Actio... View File Tools Help
Account 000-1100-00 ;’:k‘/'
Description Cash-Checking Year: v
Period Debit [M Net Change Period Balance
Beginning Balance $0.00 $0.00 $0.00 $0.00 4
Period 1 $0.00 ‘ $0.00 $0.00 $0.00
Period 2 $0.00 $0.00 $0.00 $0.00
Period 3 $0.00 l $0.00 $0.00 $0.00
Period 4 $0.00 $0.00] $0.00 $0.00
Period 5 $0.00 \ $0.00 $0.00 $0.00
Peiiod 6 ) $0.00 $0.00| $0.00] $0.00
Period 7 $25,000.00 [ $0.00| $25,000.00 $25,000.00
Period 8 $0.00 $0.00] $0.00 | $25,000.00
Period 9 $0.00 [ $0.00 $0.00 $25,000.00
Period 10 $0.00 $0.00 $0.00 $25,000.00
Period 11 $0.00 ‘ $0.00 $0.00 $25,000.00
Period 12 $0.00 $0.00 $0.00 $25,000.00
Totals $25,000.00 30.00/ $25,000.00 $25,000. EIUA
Currency
4> M [byhocontType  ~ |

It’s there!

Lab 4.1 Assignment Deliverable

In the Word document that you created, take a screen shot of your screen output
and paste it into the document. Label it Lab 4.1. Make sure your User ID is on the
screen shot!
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Lab 4.2 Vendor Invoices

Lab 4

Brenda hands you the mail, which has several invoices in it. Let’s enter them into
Accounts Payable!

Lab 4.2.1 Vendor Invoices

Click Transactions>Purchasing>Transaction Entry:

Q- |

Home »

-

Shortcuts
Report Shortcuts
Startup

User Classes

-

-

l DYNS Financial »

‘ Home

User Preferences | E{Hﬁ
Tasks

¢ Microsoft Dynamics GP ~ [Trgnsactions v] Inquiry ~ Reports v Cards ~

Sales »

C

Inventory >
Create

Payroll »
Custom X

Project >
Custom

Human Resources »

Fixed Assets »

Service Call Management  »
Contract Administration »
Preventive Maintenance »

Returns Management 3

ek

Purchase Requisitions -
Purchase Order Entry
Purchasing Batches
Receivings Transaction Entry
Enter/Match Invoices
Returns Transaction Entry
Returns Batches

Print Purchasing Documents

Edit Purchase Orders

Purchase Order Generator ¢

e "
Scheduled Pavments
Click to lookup the Vendor. Don’t forget the Document Number and Amount!

= X & wmee il @7

Save Delete Post AA Options  Additional File Print Print Tools Help Add
v v v v

¥ Note
Actions Options  Additional File Tools Help
\
Voucher No. | 00000000000009001 [ O3/ I Intercompany ~ BatchID P>
Document Type: | Invoice \ v ] Doc. Date \ 743172015 ﬁ[-ﬂ
Description Computer Pulchas% |
Vendor ID BEST BUY S F Currency ID r ID YJ
Name Best Buy ¥ ] Document Number 147983
Address ID BEST BUY 2 P.0. Number
Femit-To ID BEST BUY D Shipping Method =
Payment Terms 2% 10/Net 30 P3| Tax Schedule ID P3|
Purchases $3,150.00 1033 Amount $0.00 17
Trade Discount $0.00 Cash $0.00 <»
Freight $0.00 Check $0.00 <»
Miscellaneous $0.00 Credit Card $0.00 <»
Tax $0.00 -)‘ Terms Disc Taken $0.00
Total $3,150.00 On Account $3,150.00

Distributions | Print Check

4 4 » M |byBatchiD

& Unsaved

Click Distributions
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A . - = 3
OX v » m il T
OK Delete Default View Additional File Tools Help Add
i ¥ v . ¥  Note
Actions View  Additional File Tools Help
Vendor ID BEST BUY [ Woucher Number 00000000000000001
Vendor Name Best Buy I Document Type Invoice
Curency ID [ Functional Amount $3.150.00
Originating Amount $0.00
Co.D [/ 1 [Account [ 7Ol Type Debit Credit
Description Originating Debit Originating Credit @
Distribution Reference Corresp. Co. ID £
BB1 000-1510-00| PURCH  ~ $3,150.00 $0.00 4
BB1 000-2110-00 AVAIL v $0.00 $63.00
BB1 000-2100-00 PAY v $0.00 $3.087.00
> 3 v $0.00 $0.00
=]
Functional Totals $3.150.00 $3.150.00
Originating Totals $0.00 $0.00
Redisplay |

Lab 4

Enter in the Account number 000-1510-00 which is Office Equipment. Notice how is

booking the 2%/10 terms even though you may not take them. Click OK.
This will take you back to the Payables Transaction Entry. Click Post.

Save Delete Post AA Options  Additional File Print Print Tools Help Add

- - - - v Note

Actions Options  Additional File Tools Help
Voucher No. | 00000000000000001 |03 I~ Intercompany ~ BatchID >
Document Type: | Invoice M Doc. Date | 7/31/2015 @
Description Computer Purchase |
VYendor ID BEST BUY l: Currency ID - IDV I
Name Best Buy | Document Number 147983
Address ID BEST BUY Is) P.0. Number
Remit-To ID BEST BUY Is) Shipping Method 2|
Payment Tems | 2% 10/Net 30 P3| Tax Schedule ID P3|
Purchases $3,150.00 1099 Amount $0.00f7
Trade Discount $0.00 Cash $0.00 =»
Freight $0.00 Check $0.00 <»
Miscellaneous $0.00 Credit Card $0.00 |=p'
Tax $0.00 -)I Tems Disc Taken $0.00
Total $3,150.00 On Account $3.150.00
Apply Print Check

PRI ST —
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Next, let’s enter in the invoice from George Night, CPA as below:

= X

By

Save Delete Post AA Options  Additional File Print Print Tools Help Add

- - - - v Note

Actions Options  Additional File Tools Help
Voucher No. | 00000000000000002 | O|0)| I~ Intercompany ~ BatchID JSIES
Document Type: | Invoice v Doc. Date | 7/1/2015 ||
Description CP& Services ‘
Vendor ID GEORGE NIGHT s Currency ID FoFE]
Name George Night, CPA | Document Number | BBO!
Address ID GEORGE NIGHT P P.0. Number |
Bemit-To ID GEORGE NIGHT Is) Shipping Method Pl
Payment Terms 2% 10/Net 30 P -)I Tax Schedule ID P[-)]
Purchases $3,000.00 1099 Amount $0.00 1
Trade Discount $0.00 Cash $0.00 |<»
Freight $0.00 Check $0.00 <»
Miscellaneous $0.00 Credit Card $0.00 <»
Tax $0.00 || Terms Disc Taken $0.00
Total $3,000.00 0On Account $3,000.00
Apply | Distributions | Print Check

Click Distributions

OX v »

il @7

OK Delete Default View Additional File Tools Help Add
v v v h ¥ Note
Actions View  Additional File Tools Help
Vendor ID GEORGE NIGHT Youcher Number 00000000000000002
Vendor Name George Night, CP& | Document Type Invoice
Currency ID l Functional Amount $3,000.00
Originating Amount $0.00
Co.ID [© 7 | Account [~ 179 Type |Debit Credit
Description |Driginating Debit Originating Credit @
Distribution Reference Corresp. Co. ID 9
BB1 000-5020-0 PURCH  ~ $3,000.00 $0.00 4 |
BB1 000-2110 -OK AvalL v $0.00 $60.00
BB1 000-2100-00 \ PaY v $0.00 $2,940.00
- - - - $0.00 $0.00
N
\
N =]
Functional Totals w:zon $3,000.00
Originating Totals .00 $0.00

.

Enter in account number 000-5030-00 and the below

Redisplay |

ill pop up:

Lab 4

10
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Microsoft Dynamics GP
@ Which type of account do you want to add?
Posting Unit Allocation
Click Posting
H9X i« §l @7
Save Clear Delete File Print Tools Help Add
7 ¥ Note
Actions File Tools Help
Account 000-5030-00 PO 1 inactive
D ipti -Professional Services-
Alias I v Allow Account Entry
Category Administrative Expense
i~ Posting Type: Level of Posting from Series:
Sales: Detail v
Inventory Control: Detail v [Pr]l;?:?l; ;Ivngonlrol
Purchasing: Detail v Pay ol
Payroll: Detail - _
User-Defined 1 [

User-Defined 2

/

ser-Defined 3

ed 4
sNy

/
/
#et I Analysis | Cunench

)

v =

‘M« > ¥ [byhccod tType

Lab 4

Enter the Description. Use the L/okupmcmegory and make sure that you

change the Posting Type to Profit and Loss and the Typical Balance to Debit. Save

this screen and close the window.

11



Brenda’s Bagels

OX v »m | f @0

Delete Default Vlew Addmonal Flle Tools Help Add

¥ Note
Actions View  Additional File Tools Help
Venilor ID GEORGE NIGHT I Youcher Number 00000000000000002
Vendor Name George Night, CPA | Document Type Invoice
Currgncy ID I Functional Amount $3,000.00
Originating Amount $0.00
Co. 10} [~ 1 [ Account [5 17 [ Type |Debit Credit
Description IElliginaling Debit Originating Credit 2
Distribiition Reference Corresp. Co. ID
BE1 000-5030-00 PURCH $3,000.00 $0.00 4§
BB1 000-2110-00 AVAIL v $0.00 $60.00
BB1 000-2100-00 PAY v $0.00 $2,940.00
° ° > $0.00 $0.00
-
Functional Totals $3.000.00 $3,000.00
Rate: Originating Totals $0.00 $0.00
Redisplay
Click OK.
= A 6,7 E .
X & rEE =] Woe il @0
Save Delete Options  Additional File Print Print Tools Help Add
- - - - v Note
Actlof Options  Additional File Tools Help
Voucher No. I 00000000000000002 | O/ I Intercompany Batch ID P>
Document TypeI Invoice v Doc. Date [7/1 /2015 EI-)I
Description T CP4 Services |
Vendor ID I GEORGE NIGHT ! Currency ID O]
Name ’ George Night, CPA | Document Number BBO1
Address ID ’ GEORGE NIGHT Is P.0. Number
Remit-To ID’ GEORGE NIGHT Is) Shipping Method PI
2% 10Met 30 93] TaxSchedueld P
$3,000.00 1093 Amount $0.00f
Trade Dlscount $0.00 Cash $0.00/
Freight | $0.00 Check $000
Misce‘neous $0.00 Credit Card $0.00 <
Tar | $0.00 <3| Terms Disc Taken $0.00
Tula’ $3,000.00 On Account $3,000.00
Print Check
¥
| |1 < » ¥ [byBatchiD - Status|Unsaved |

/

Post this invoice.

Lab 4

12
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E:. ::\ =T G =3 g 3
X &k 2 W il @7
Save Delete Post AA Options  Additional File Print Print Tools Help Add
- - - v ~  Note
Actions Options ~ Additional File Tools Help
Voucher No. | 00000000000000003 |93 I Intercompany ~ BatchID P>
Document Type: Invoice v Doc. Date I 743172015 ﬂl-)[
Description Delivery Vehicle |
VYendor ID HENRY'S L Currency ID 3 ‘D}I ‘
Name Henry's Used Cars ‘ Document Number BBCAR
Address 1D HENRY'S ,,0 P.0. Number
Remit-To D HENRY'S Is) Shipping Method 2
Boyment Tems | 2% 10/Net 30 P3| TaSchedied P
Purchases $2,400.00 1093 Amount $0.00f7
Trade Discount $0.00 Cash $0.00 <»
Freight $0.00 Check. $0.00 |=»
Miscellaneous $0.00 Credit Card $0.00 <»
Tax $0.00 || Temms Disc Taken $0.00
Total $2,400.00 On Account $2.400.00
Apply Print Check

Next, let’s into in the car that Brenda purchased for the business. Enter in the

information as above and click Distributions.

OX v » ™ & fl @7
OK Delete Default View Additional Flle Tools Help Add
v M i Y Note
Actions View  Additional File Tools Help
Vendor ID HENRY'S l Woucher Number 00000000000000003
Vendor Name Henry's Used Cars | Document Type Invoice
Currency ID | Functional Amount $2,400.00
Originating Amount $0.00
Co.I0 [© ¥ [Account [ 7 [ O[] Type | Debit Credit ®
DESC"DUDH i Originating Debit Originating Credit @
Distribution Reference Corresp. Co. ID L
BB1 000-1530-00 v $2,400.00 $0.00 |
BB1 000-2110-00 AVAIL v $0.00 $48.00
BB1 000-2100-00 PaY v $0.00 $2,352.00
- - { 1~ $0.00 $0.00
|
Functional Totals $2,400.00 $2,400.00
Rates Originating Totals $0.00 $0.00
Redisplay

Lab 4

Enter in the account number and click OK. This brings you back to the main menu.

You notice the terms do not match the invoice.

13
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Lab 4

=
=i =) T s = iﬂ 3
WX&ak 5 7 @
Save Delete Post AA Options  Additional File Print Print Tools Help
- - - - -
Actions Options  Additional File Tools Help
Voucher No. 00000000000000003 |9/ I Intercompany Batch ID P>
Document Type: | Invoice - Doc. Date | 7/31/2015 ||
Description Delivery Vehicle |
¥endor ID HENRY'S L Currency ID iy |DIrr ]
Name Henry's Used Cars I Document Number BBCAR
Address 1D HENRY'S 2 P.0. Number
Femit-To D HENRY'S IS Shipping Method Pl
Payment Terms Net 30 Is) ')] Tax Schedule ID P|-)]
Purchases 240000 1099 Amount $0.00"
Trade Discount xﬂﬂ Cash $0.00 <»
Freight $0. Check $0.00 |=»
Miscellaneous $0.00 Credit Card $0.00 | <»
Tax $0.00 < Terms Disc Taken $0.00
Total $2,400.00 Account $2,400.00
Apply I Distributions I Print Check
N
4 4 > »l |byBatchD - Status| Unsaved N |

Click the lookup and change the terms to

et 30. Click Distributions again.

N ) — 3
OX v » m il @7
OK Delete Default View Additional File Tools Help Add
N % g h ¥ Note
Actions View  Additional File Tools Help
Vendor ID HENRY'S | Youcher Number 00000000000000003
Vendor Name Henry's Used Cars ] Document Type Invoice
Currency ID l Functional Amount $2.,400.00
Originating Amount $0.00
Co.I0 [ 17 | Account [ 1719/ Type |Debit Credit &
Description lUriginaling Debit Originating Credit Y,
Distribution Reference Corresp. Co. ID
BE1 000-1530-00 PURCH v $2,400.00 $0.00 |
BE1 000-2100-00 PaY v $0.00 $2,400.00
BE1 000-2110-00 AVaIL v $0.00 $0.00
R = ~ $0.00 $0.00
-
Functional Totals $2.,400.00 $2,400.00
] | Originating Totals $0.00 $0.00

Change the accounts and click Redisplay. Click OK.

14
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X 6

Save Delete Post

Options  Additional

e il @0

File Print Print Tools Help Add

hd ¥ Note
Actighs Options  Additional File Tools Help
Voucher No. ’ 00000000000000003 | O/ I Intercompany  BatchID P>
Document Typi Invoice v Doc. Date I 7/31/2015 ﬁl#‘
Description [ Delivery Vehicle ]
VYendor ID HENRY'S P Currency 1D r l[]rr |
Name T Henry's Used Cars Document Number BBCAR
AddressID HENRY'S Js) P.0. Number
RemitTo 0 HENRY'S I Shipping Method sl
Net 30 PP IasSchedued P>
$2.400.00 1099 Amount $0.00f
Trade Dlscount $0.00 Cash $0.00 <
Freigh $0.00 Check $0.00 <»
Miscelaneous $0.00 Credit Card $0.00 <»
Tax | $0.00 || Temms Disc Taken $0.00
Totall $2,400.00 On Account $2,400.00
Apply I Distributions I Print Check
{5 o1 s T —

PoOst this invoice.

= X &) 0

Save Delete Post AA Options  Additional
- -

i

C B

File Print Print
-

il @3

Tools Help Add

N ¥ Note
Actions Options  Additional File Tools Help

Voucher No. | 00000000000000004 |3 I Intercompany ~ BatchID JES
Document Type: | Invoice < Doc. Date | 7/31/2015 @
Description Office Supplies ]
Vendor ID OFFICE DEPOT [ Currercy 1D O]
Name Office Depot Document Number 16940372
Address ID OFFICE DEPOT P P.0. Number
Remit-To ID OFFICE DEPOT I3 Shipping Method Is)
Payment Terms Net 30 Is -)] Tax Schedule ID 2 -)]
Purchases $547.52 1099 Amount $0.00 7
Trade Discount [$U.00) Cash $0.00 |=»
Freight $0.00 Check $0.00 |=»
Miscellaneous $0.00 Credit Card $0.00 | <»
Tax $0.00 <3| Terms Disc Taken $0.00
Total $547.52 On Account $547.52

Apply l Distributions | Print Check
4 4 » » [byBatchiD -] Status|Unsaved |

Enter in the invoice for Office Depot. Remember to change the Payment Terms.

Click Distributions.

Lab 4

15
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OX v T | il @O

OK Delete Default View Additional File  Tools Help Add

Y- i hd i ¥ Note
Actions View  Additional File Tools Help
Yendor ID OFFICE DEPOT Woucher Number 00000000000000004
Yendor Name Office Depot | Document Type Invoice
Currency ID | Functional Amount $547.52
Originating Amount $0.00
Co.ID |71 | Account [ 17 19| Type | Debit Credi
Description iDliginaling Debit Originating Credit @
Distribution Reference Corresp. Co. ID L
BB1 000-5270-00 v $547.52 $0.00 4|
BB1 000-2100-00 P&Y v $0.00 $547.52
B - [ R4 $0.00 $0.00
Functional Totals $547.52 $547.52
Rates I Originating Totals $0.00 $0.00

Redisplay I

Lab 4

Let’s book this to Supplies Expense. Click OK on the Distribution window and then

Post the invoice.

16
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Lab 4

Let’s enter in some invoices for Bagel purchases. We bought the following from The

Bagel Bakery:

Sale Date:

Blueberry Bagel

Chocolate Chip Bagel

Cinnamon Bagel
Plain Bagels
Whole Wheat Bagel

Don'’t forget to put in the right invoice date and the Document Number.

7/5/15
Unit Price Quantity
$0.35 15
$0.50 20
$0.35 18
$0.25 36
$0.30 24

Extended
Cost
$5.25

$10.00
$6.30
$9.00
$7.20

$37.75

WX &%= & = il @
1 = = (i )
= a = % - i & j
Save Delete Post AA Options  Additional File  Print Pri Tools Help Add
- v - v v Note
Actions Options  Additional File ools Help
Voucher No. 00000000000000005 ¢O AT Intercompany Batch ID N} P <>
Document Type: Invoice Doc. Date | 7/5/201 | >
Description 7/5/15
Vendor ID BAGEL BAKERY » Currency ID | < g
Name The Bagel Bakery Document Number 7.5.15
Address 1D BAGEL BAKERY p P.0. Number
Remit-To ID BAGEL BAKERY Is Shipping Method P
Payment Terms 2% 10/Net 30 POl Tax Schedule ID P>
Purchases $37.75 1093 Amount $0.00 7
Trade Discount [30.U0) Cash $0.00 |
Freight $0.00 Check $0.00 |<»
Miscellaneous $0.00 Credit Card $0.00 <
Tax $0.00 | <» Terms Disc Taken $0.00
Total $37.75 On Account $37.75
Distributions Print Check
14 4 » »l|byBatchID v Status | Unsaved
Click Distributions

17
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OX v » @ | il @0

OK Delete Default View Additional File Tools Help Add

¥ Note

Actions View  Additional File Tools Help
Yendor ID BAGEL BAKERY ‘ Woucher Number 00000000000000005
Yendor Name The Bagel Bakery I Document Type Invoice
Currency ID ‘ Functional Amount $37.75
Originating Amount $0.00
Co.ID [ 7 | Account =7 |w Type Debit Credit
Description Originating Debit Originating Credit @
Distribution Reference Corresp. Co. ID i
BB1 000 -4500-00 v $37.75 $0.00 4
BE1 000-2110-00 AVaIL v $0.00 $0.76
EB1 000-2100-00 PaY N\~ $0.00 $36.99
{ ] $0.00 $0.00
AN
N\
N\
\\ L
Functional Totals 75 $37.75
Rates Originating Totals $0. $0.00

Redisplay I I

Lab 4

If you want to see what account this is, click the Lookup. Click OK and Post on the
Payables Transaction Entry window. Don’t worry. We will bill the customer later!
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Brenda'’s Bagels

Let’s enter the invoice for the purchase of goods for the next sale in July:

Sale Date:

Blueberry Bagel
Chocolate Chip Bagel
Cinnamon Bagel
Plain Bagels

Whole Wheat Bagel

Don'’t forget to put the invoice date i

EXabkE 5 &

7/11/15
Extended
Unit Price  Quantity Cost
$0.35 24 $8.40
$0.50 36 $18.00
$0.35 30 $10.50
$0.25 50 $12.50
$0.30 40 $12.00
$61.40

==\l @

Save Delete Post AA Options  Additional File Print Print ools Help Add

v v v " ¥ Note

Actions Options  Additional File ToRls Help

Voucher No. 00000000000000006 | O/ I Intercompany Batch ID N D>
Document Type: | Invoice v Doc. Date | 7/11/2015 |-
Description 7411415
Vendor ID BAGEL BAKERY C Currency ID »
Name The Bagel Bakery Document Number 71115
Address ID BAGEL BAKERY p P.0. Number
Bemit-To ID BAGEL BAKERY p Shipping Method ,Q
Payment Terms 2% 10/Net 30 p <> Tax Schedule ID p <>
Purchases $61.40 1099 Amount $0.00 ¥
Trade Discount $0.00 Cash $0.00 |=»
Freight $0.00 Check $0.00 «»
Miscellaneous $0.00 Credit Card $0.00 |«»
Tax $0.00 | <» Tems Disc Taken $0.00
Total $61.40 On Account $61.40

14 4 » »l |byBatchID

Click Distributions.

Print Check

and the Document Number.

Lab 4
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Brenda'’s Bagels

OX v » T Il @]
OK Delete Default View Additional File Tools Help Add
v A A v ¥ Note
Actions View  Additional File Tools Help
Vendor ID BAGEL BAKERY Voucher Number 00000000000000006
Wendor Name The Bagel Bakery Document Type Invoice
Currency ID Functional Amount $61.40
Originating Amount $0.00
Co. ID ‘,/7 . | Account £ ,,O “» Type Debit Credit @
Description QOriginating Debit Originating Credit @
Distribution Reference Corresp. Co. ID {
BE1 000 -4500 -00 FURCH  Rg $61.40 $0.00 4|
BB1 000-2110-00 AvalL v $0.00 $1.23
BB1 000-2100-00 PaY v $0.00 $60.17
£ o ~ $0.00 $0.00
Functional Totals $61.40 $61.40
Originating Totals $0.00 $0.00
Redisplay

Click OK and then post the invoice.

Enter the next one!

Sale Date:

Blueberry Bagel
Chocolate Chip Bagel
Cinnamon Bagel
Plain Bagels

Whole Wheat Bagel

7/22/15
Extended
Unit Price  Quantity Cost
$0.35 35 $12.25
$0.50 50 $25.00
$0.35 40 $14.00
$0.25 80 $20.00
$0.30 60 $18.00
$89.25

Lab 4
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Brenda’s Bagels

& X &k B W il @7
Save Delete Post AA Options  Additional File Print Print Tools Help Add

- - - - >~ Note

Actions Options  Additional File Tools Help
Voucher No. | 00000000000000007 | O)3| I~ Intercompany ~ BatchID
Document Type: | Invaice M Doc. Date | 7/22/2015 &
Description 7.2215 |
Vendor ID BAGEL BAKERY [ Currency ID o]
Name The Bagel Bakery | Document Number | 7.2215)
Address ID BAGEL BAKERY Is) P.0. Number
Bemit-To ID BAGEL BAKERY - Shipping Method - I
Payment Tems | 2% 10/Net 30 PP IsuSchedueld =
Purchases $89.25 1099 Amount $0.00 7
Trade Discount $0.00 Cash $0.00 =»
Freight $0.00 Check $0.00 |=»
Miscellaneous $0.00 Credit Card $0.00 <
Tax $0.00| | Terms Disc Taken $0.00
Total $89.25 On Account $89.25
Apply | Distributions I Print Check

OX v | i @7

OK Delete Default View Additional File  Tools Help Add

v < < < ¥ Note
Actions View  Additional File  Tools Help
Wendor ID BAGEL BAKERY I Youcher Number 00000000000000007
Wendor Name The Bagel Bakery | Document Type Invoice
Currency ID I Functional Amount $89.25
Originating Amount $0.00
Co.ID [~} | Account [~ 172> Type Debit Credit @
Description Originating Debit Originating Credit ¥
Distribution Reference Corresp. Co. ID
BB1 000 -4500-00] PURCH ~ $89.25 $0.00 4|
BB1 000-2110-00 AVAIL v $0.00 $1.79
BB1 000-2100-00 PaY v $0.00 $87.46
s S M $0.00 $0.00
<
Functional Totals $89.25 $89.25
Rates I Originating Totals $0.00 $0.00

Redisplay |

Lab 4
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Brenda'’s Bagels

Last one!

Sale Date:

Blueberry Bagel
Chocolate Chip Bagel
Cinnamon Bagel
Plain Bagels

Whole Wheat Bagel

WX&at 5 %

7/30/15

Unit Price Quantity
$0.35 10
$0.50 50
$0.35 75
$0.25 60
$0.30 60

It

4

Save Delete Post AA Options  Additional File Print Print Tools
v v v v

=vE lful ‘Qj

Help Add

v

Note
Help

Doc. Date | 7/30/2015

Distributions

Extended

Cost
$3.50
$25.00
$26.25
$15.00
$18.00

$87.75

o>
@

e

$0.00
$0.00 |<p
$0.00 |<p
$0.00 |<p
$0.00
$87.75

Print Check

Actions Options  Additional File Tools
Voucher No. 00000000000000008 p T Intercompany Batch ID
Document Type: | Invoice v
Description 7.3015
¥Yendor ID BAGEL BAKERY Currency ID
Name The Bagel Bakery Document Number 7.30.15
Address 1D BAGEL BAKERY p P.0. Number
Remit-To 1D BAGEL BAKERY Is) Shipping Method
Payment Terms 2% 10/Net 30 D> Tax Schedule ID
Purchases $87.75 1039 Amount
Trade Discount [$U.U0) Cash
Freight $0.00 Check
Miscellaneous $0.00 Credit Card
Tax $0.00 =» Terms Disc Taken
Total $87.75 On Account
14 4 » » | byBatchID v Status | Unsaved

Lab 4
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Brenda’s Bagels

OK Delete Default View
-

OX v » T | il @7

Additional File  Tools Help Add
-

v hd ¥ Note
Actions View Additional File Tools Help
Wendor ID BAGEL BAKERY ] Youcher Number 00000000000000008
Yendor Name The Bagel Bakery ‘ Document Type Invoice
Currency 1D I Functional Amount $87.75
Originating Amaount $0.00
Co.I0 [ 17 | Account [ 17 | 2| Type | Debit Credit ®
Description ]Uliginaling Debit Originating Credit @
Distribution Reference Carresp. Co. ID L
BB1 000-4500-00]| PURCH ~ $87.75 $0.00 4
BB1 000-2110-00 AVAIL v $0.00 $1.76
BB1 000-2100-00 PaY v $0.00 $85.93
S S > $0.00 $0.00
B
Functional Totals $87.75 $87.75
Rates I Originating Totals $0.00 $0.00
Redisplay |

Lab 4

We're done! Close the Payables Transaction Entry window! Print the invoices if you
want or hit Cancel.

The last step is to post to the General Ledger! Click Transactions>Financial>Series

Post

LuMiosoftDynamicsGP

QO- |

Home

b Shortcuts

Startup

iUser Preferences |

I Report Shortcuts

Sales

Purchasing
Payroll
Fixed Assets

Returns Management

General

4 Clearing
Quick Journal
Batches

A Microsoft Dynar

vy v v v

Check forrayromexop

Bank Deposit

Bank Transactions
Miscellaneous Check
Bank Transfers

Reconcile Bank Statement

Transaction Matching

Transaction Matching

Groups
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Brenda’s Bagels

¢ | il @7

display File  Tools Help Add
v

v ¥ Note
File Tools Help
Display Batches: & Maked | Makal | Upmakar |
Batch ID | Origin \ Status |®
Comment | UserID No.of Trx | Posted I Frequency [@
MTFv‘X General Entry Marked =
\
A N
\ \
\
A Y
\ 1
\ -
i ¥
byBatchD | |

Click to check the box of what you want to post and click Post. Print or Cancel.

=2 = ﬂ

g€ ¢ W

Post Redisplay File  Tools Help Add

b Y Y Note
Actions File Tools Help

Display Batches: @ Al Maked | Makal | Unmakal |
Batch ID | oiigin Status ®
Comment |User D No. of Trx Posted IFlequency |@
a1 General Entry No Transactions =]
by Batch ID v

They are gone! Close this window.

24
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Brenda’s Bagels

Let’s see if our invoices are there! Click Reports>Purchasing>Trial Balance

A Microsoft Dynamics GP ~  Transactions ~ Inquiry ~ [ Reports v] Cards ~

e Student1's Home System » | Customize this page:;
" Userpreerences | {7} oo Compeny '
b Shortcuts - —r Einancial 4
b Report Shortcuts Tasks N Sales : 4
Startup Customer Expetience Improvement Pro Trial Balance
Check for Payroll tax updates Ioventory ' History
| Payroll > Analysis
d Customized Check Informatic
Combined Group Posting Journals
Human Resources » Setup/Lists
Fixed Assets » Groups
Returns Management » |
Workflow wed for 2015
ed |
Letter Writing Assistant I _"ﬂ

s Template Maintenance
") Quick Links Template Configuration
— - —

Click Detail and Insert, then Print

3
ok W
Clear ail File Print Help Add
Y ¥ Note

Actfons File Help
Hepﬁs; ‘
|Agﬁ Trial Balance ‘ > |

ions: Email or Print List:

Aged Trial Balance-Detail

Summary

New Modify

Lab 4
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Brenda'’s Bagels

Report Destination

Report Information

Name: Aged Trial Balance

Option: Detail
v Ask Each Time

Destination

Report Type: Standard

[V Screen

™ File

File Name:

File Format: Text file

& A ppend

" Replace

| oK | Cancel

Make sure Screen is checked and Printer is not.

Click OK.

&b Pint 2= SendTo 4] Modiy | ~| | Completed 2 Pages Page 1
System: 10/672015 23731 Pl
System: 107672013 AGED TRIAL BALANCE B
Brenda's Bagels Inc. 1 [}
Payables Management
Ranges:
Vendor 1D: First - Last User-Defined 1: First - Last
Vendor Class:  First - Last Posting Date: First - Last
Payment Priority: First - Last Document Number: First - Last
Vendor Name: ~ First - Last
* - Indicates an unposted credit document that has been applied.
Vendor ID: BAGEL BAKERY Name: The Bagel Bakery Class ID: STANDARD
Voucher/ Writeoft
Payment No. Doc Number Type Doc Date Due Date Doc Amount Disc Avail Amount ___Current Period
00000000000000005 _ 7.5.15 INV /2015 8412015 537.75
00000000000000008  7.11.15 INV 15 8102015 $81.40
00000000000000007  7.22.15 INV 812112015 $89.25
00000000000000008  7.30.15 INV $87.75
Due
Voucher(s): 4 Aged Totals: $276.15 $0.00
Vendor ID: BEST BUY Name: Best Buy Class ID: STANDARD
Voucher/ Writeoff
Payment No. Doc Number Type Doc Date Doc Amount Disc Avail Amount Current Period
00000000000000001 _ 147583 INV 77112015 52,137.98
Due
Voucher(s): 1 Aged Totals: $2.137.98 $0.00
Vendor ID: GEORGE NIGHT Class ID: STANDARD
Voucher/ Writeoff
)yment No. Doc Number Doc Amount Disc Avail Amount Current Period
00000000000000002 _ B801 $3,000.00
Due
Voucher(s): 1 Aged Totals: $3,000.00 $0.00
Vendor ID: HENRY'S Class ID: STANDARD
Voucher/ Writeoff
Payment No. Doc Number Doc Amount _Disc Date Disc Avail Amount __Current Period
00000000000000003 _ BB7.1.15 52.400.00
Due
Voucher(s): 1 Aged Totals: $2,400.00 $0.00

Vendor ID: OFFICE DEPOT

Name: Office Depot

Lab 4.2 Assignment Deliverable

In the Word document that you created, take a screen shot of your screen output

Class ID: STANDARD

Lab 4

and paste it into the document. Label it Lab 4.2. Make sure your user ID is in the
screen shot! Close the window and move on to Lab 4.3!
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Brenda’s Bagels

Lab 4.3 Customer Invoices

Lab 4.3.1 Invoice Customers

Let’s invoice our customers for the sales in July. Click
Transactions>Sales>Transaction Entry

TP \

\/\)' | Home »

| Home |
User Preferences
Shortcuts

Report Shortcuts
Startup

v v

[Trgnsactions ~| Inquiry v Reports + Cards ~
Studer

Einancial

Purchasing

Payroll

4 Microsoft Dynami

Sales Transaction Entry
Sales Batches

Print Sales Documents

Tasks . ]
c Fixed Assets Order Fulfillment
i
o Returns Management Holds Processing
Check forreyromrmaxupuares
Customer/Vendor Transactions
Transfer Multiple Orders
Automatic Order Allocation
Bulk Print
Bulk Confirmation
Invoice Entry
Invoicing Batches
(5 Scheduled Payments
0 Quick Links .
_ Cash Receipts
Master Posting
Summary Inquiry Apply Sales Documents
Payables Summary Inquiry Refund Checks
Receivables Summar)f Inquiry Lockbox Entry
Budget vs Actual Inquiry X
Series Post

Checkbook Balance Inquiry

Reconcile Bank Statements

View Transactions Pending Approval List
Finance Community

Cash Flow Calendar

Posted Transactions
Edit Transaction Information
Receivables Batches

Generate EFT File

Lab 4
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Brenda'’s Bagels Lab 4

Remember our first Bagel Bakery invoice? Here’'s what we sold the bagels we
purchased for:

Sale Date: 7/5/15 Customer: Joe's Catering
Selling Extended Selling

Quantity Price Price

Blueberry Bagel 15 $1.50 $22.50
Chocolate Chip Bagel 20 $1.75 $35.00
Cinnamon Bagel 18 $1.50 $27.00
Plain Bagels 36 $1.25 $45.00
Whole Wheat Bagel 24 $1.35 $32.40
$161.90

We need to bill Joe’s Catering for $161.90

EHX&ak 5 sEas«s® il @70

11

Save Delete Post AA Options ~ View File Print Print E-mail Tools Help Add
v v - v v Note
Actions Options ~ View File Tools Help
Document Type: Sales / Invoices v Batch ID ,/O >
Number SALES000000000001 p O Document Date
Descriptior
Customer ID JOES CATERING V- E Currency ID
Name Joe's Catering Payment Terms
Address D I Shipping Method
Salesperson ID 70 Tax Schedule ID
Teitory 1D ¢O P.0. Number
Cost Cash
Sales Chec.k
Trade Discount CiedlCad
2 Terms Disc Taken

Freight

5 On Account
Miscellaneous
Tax $.00 <>
Total Distribution Commissions
14 4 » »l |byDocument Status | Unsaved

Hit the Tab key and a Nuraber will be automatically assigned.\Enter the Customer
ID, Payment Terms and Sales Amount. Don’t forget the Document Date. Click
Distribution.
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Brenda’s Bagels

Actions

- v

View  Additional

OX v prh | il @7

OK Delete Default View Additional

File  Tools Help Add
b4 b Y Note

File Tools Help

Customer ID JOES CATERING

Document No.

SALES000000000001

Name Joe's Catering Document Type Sales / Invoices
Currency ID | Functional Amount $161.90
Originating Amount $0.00
Account e O |3/ Type Debit Credit 2
Description Originating Debit Originating Credit @
Distribution Reference
000-4100-00 ISALES v $0.00 $161.90 |
000-2110-00 AVAIL v $3.24 $0.00
000-1200-00 v $158.66 $0.00
> o | $0.00 $0.00
v
Functional Totals $161.90 $161.90
Originating Totals $0.00 $0.00

Lab 4

Click OK. Click Post in the Receivables Transaction window and the below will pop

up. Click Ye

o

S.

This\transaction exceeds the customer's credit limit. Do you want

to continue?
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Brenda'’s Bagels

Let’s do another one! Enter it in the exact same way! Don’t forget to Post it!

Sale Date:

Blueberry Bagel
Chocolate Chip Bagel
Cinnamon Bagel
Plain Bagels

Whole Wheat Bagel

WX &k 5 8

7/11/15

Customer:

Selling

Quantity

24
36
30
50
40

Price
$1.50
$1.75
$1.50
$1.25
$1.35

]

Beth's Bath World

Extended Selling

Price
$36.00
$63.00
$45.00
$62.50
$54.00

$260.50

Save Delete Post AA Options ~ View File Print Print E-mail Tools Help Add
- - - - ~  Note
Actions Options ~ View File Tools Help
Document Type: Sales / Invoices v Batch ID ‘D =Y
Number SALES000000000002 p ] Document Date 71172015 (>
Description
Customer ID BETH'S 5 Currency 1D EToF
Name Beth's Bath World Payment Terms 2% 10/Net 30 ,/O kd
Address ID BETHS D Shipping Method D)
Salesperson ID D Tax Schedule ID D>
Teritory ID yo P.0. Number
Cost $0.00 Cash $0.00 <
Sales $26050 Eheck sggg %
Trade Discount $000 ErediCard zn.uo s
Freight $0.00 ;exms Disc Taken szso.so
Miscellaneous $0.00 Didccounk -
Tax $0.00 <
Total $260.50 Commissigns
14 4 » »  byDocument v Status | Unsaved
g - =
OX v » T il @7
OK  Delete Default View Additional File  Tools Help Add
v v - - ¥ Note
Actions View  Additional File Tools Help
Customer ID BETH'S Document No. SALES000000000002
Name Beth's Bath World Document Type Sales / Invoices
Currency ID Functional Amount $280.504
Originating Amount $0.DD_
Account 'E.?a/(_) 2| Type Debit Credit @
Description Originating Debit Originating Credit @
Distribution Reference
000-4100-00 SALES v $0.00 $260.50 4|
000-2110-00 AVAIL v $5.21 $0.00
000-1200-00 RECY v $255.29 $0.00
= = v $0.00 $0.00
|
Functional Totals $260.50 $260.50
Originating Totals $0.00 $0.00

Lab 4
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And another one!

Sale Date:

7/22/15 Customer:

Selling
Price
$1.50
$1.75
$1.50
$1.25
$1.35

Quantity
Blueberry Bagel 35

Chocolate Chip Bagel 50
Cinnamon Bagel 40
Plain Bagels 80
Whole Wheat Bagel 60

Pet Planet Grooming

Extended Selling
Price
$52.50
$87.50
$60.00
$100.00
$81.00

AX&E 5 »

Save Delete Post

o

$381.00

il @

AA Options ~ View File Print Print E-mail Tools Help Add
v v v

v Y Note
Actions Options ~ View File Tools Help
Document Type: Sales / Invoices v Batch ID D>
Number SALES000000000003 :Q D Document Date 7/22/2015 |-
Description
Customer ID PET PLANET FE Currency 1D T
Name Pet Planet Grooming Payment Terms 2% 10/Net 30 p Ll
Address ID PETS / Shipping Method Vs
Salesperson ID D) Tax Schedule ID >
Teritory ID ,,O P.0. Number
Cost $0.00 Cash $0.00 =
Sales $381.00 Chach *ggg o
Trade Discount $0.00 Ciedt Cérd :0 % 2
Freight $0.00 Terms Disc Taken $SB1.UU
Miscellaneous $0.00 Onicoount :
Tax $0.00 |<p
Total $381.00 Commissigns
14 4 » Pl |byDocument < Status | Unsaved
OXwp ™ @il @
- ¥ i -
OK Delete Default View Additional File Tools Help Add
v v v v ¥ Note
Actions View  Additional File Tools Help
Customer ID PET PLANET Document No. SALES000000000003
Name Pet Planet Grooming Document Type Sales / Invoices
Currency ID Functional Amount $381.00
Originating Amount $0.00
Account e, 97 | Type Debit Credit ®
Description Originating Debit Originating Credit @
Distribution Reference
000-4100-00 SALES v $0.00 $381.00 «
000-2100-00 AVAIL v $7.62 $0.00
000-1200-00| RECY v $373.38 $0.00
> = v $0.00 $0.00
v
Functional Totals $381.00 $381.00
Originating Totals $0.00 $0.00

Lab 4
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And one more!

Sale Date: 7/30/15

Quantity
10

50
75
60
60

Blueberry Bagel
Chocolate Chip Bagel
Cinnamon Bagel
Plain Bagels

Whole Wheat Bagel

Customer:

Lab 4

Beth's Bath World

Extended Selling
Price
$15.00
$87.50
$112.50
$75.00
$81.00

$371.00

Selling
Price

$1.50
$1.75
$1.50
$1.25
$1.35

S = W o > = y f ~
WX &k 5 pEgSsR (| @0
Save |Delete Post AA Options ~ View File Print Print E-mail Tools Help Add
b4 v v b v Note
Actions Options ~ View File | Tools Help
Document Type: Sales / Invoices - Batch D P >
Number SALES000000000004 p 0O Document Date 7/30/2015 |-
Description
Customer 1D BETH'S Currency ID
Name Beth's Bath World Payment Terms 2% 10/Net 30 P>
Address 1D BETHS s Shipping Method )
Salesperson 1D Is Tas Schedule ID P>
Teritory ID p P.0. Number
Cost $0.00 Cash $0.00 <
Sales $371.00 Check 000/
Trade Discount $0.00 Cred Card 00|
Freight $0.00 Terms Disc Taken $0.00
Miscellaneous $0.00 Oniccount $37100
Tax $0.00 |=»
Total $371.00 Lommissions
14 € » »l |byDocument v Status | Unsaved
\0\ x 4 ﬁ 1 l ‘0‘
-/ ¥ 2z | uu * j
OK  Delete Default View Additional File Tools Help Add
= v v v ¥ Note
Actions View Additional File Tools Help
Customer ID BETH'S Document No. SALES000000000004
Name Beth's Bath World Document Type Sales / Invoices
Currency ID Functional Amount $371.00
Originating Amount $0.00
Account q?‘.;o 2 <p Type Debit Credit @
Description Originating Debit Originating Credit @_
Distribution Reference
000-4100-00 SALES v $0.00 $371.UU£
000-2100-00 AVAIL v $7.42 $0.00
000-1200-00 RECY v $363.58 $0.00
- - v $0.00 $0.00
Functional Totals $371.00 $371.00
Originating Totals $0.00 $0.00

Don'’t forget to Post! Close the window.
or print them.

You can hit Cancel when it asks you to print
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Let’s post to the General Ledger! Click Transactions>Financial>Series Post

@@ @ | Home »

[Trgnsactions v] Inquiry ~ Reports ~ Cards ~ A Microsoft Dynar
e Studer General
{User Preferences Sales ’ Clearing
Purchasin 4 ick Journal
b Shortcuts Reminde 9 Quick Jou
b Report Shortcuts Payroll 4 Batches
Tasks . .
Custom Returns Management >

Check forreyrommaxop Bank Deposi
Bank Transactions

Miscellaneous Check
Bank Transfers

Reconcile Bank Statement

Transaction Matching

Transaction Matching Groups

&€ ¢ | {l @7
Po: edisplay File  Tools Help Add
b 7 ¥ Note
Action: File Tools Help
IDispIayBa!ches: " Marked I Mark All | Unmark All I
Batch D [origin | status @
Comment \ | User ID No. of Tre | Posted I Frequency [@
WRMSLS 00000001 General Entry \ Marked =}
SN
\ N
A\ N
A N
A N
\ N
\ N
A\ N ||
B e =
A

by Batch ID ‘ v \

Click to check the box of what you want to post and click Post. Print or Cancel.
Their gone! Close this window.

=X ~ ﬂ
& ¢« W
Post Redisplay File  Tools Help Add
2 b4 e Note
Actions File Tools Help
| Display Batches: @ Al O Maked | Mark Al Unmark All
Batch ID Origin Status
Comment |User D No. of Trz |Posled ]Flequency I@
a1 General Entry No Transactions A
v
by Batch ID v
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Let’s see if there are there! Click Reports>Sales>Trial Balance.

A\ Microsoft Dynamics GP

{ () e
AT, I Home »
Transactions ~ Inquiry vl Reports vl Cards ~ i Microsoft Dynamics GP ~
' System
Home Student1's Home Y
Company
U
ser Preferences | f! To Do e
b Shortcuts Financial
Reminders
I Report Shortcuts o Sales Trial Balance
Startup Customers Over Credit Limit* (1) .
. Purchasing History
Past Due Customer Transactions” ($11
Inventory Analysis
Task Payroll Posting Journals
Customized Setup

Customer Experience Improvement Pr
Check for Payroll tax updates

Combined Group

Human
Fixed Assets

Returns Management
Workflow

Letter Writing Assistant

Template Maintenance

Template Configuration

Groups

Activity

¢ Quick Links

Do e |l @7

Clear Email File Print Tools Help Add
ud > ¥ Note

Actions File Tools Help

Reports:

Aged Trial Balance

Email or Print List:

\
Options: \

SunfNary

{Emove

N eA | Modiy
2

Aged Trial Balance-Detail

[\

Click Detail, Insert, and Prin

t.

Lab 4
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Report Destination

— Report Information
Name: Aged Trial Balance
Option: Detail

[V &sk Each Time

" Destination

Report Type: | Standard

[~ Printer
[~ File

File N ame; I r ‘l
File Format: ITF::-:t file - |
¢ Append € Feplace
| oK I Cancel
&p Pint (=] SendTo &) Modiy | 100% ~ | Completed 1 Page ’PagT

System: 1011472015 1:51:48 PM
User Date: 1011412015

AGED TRIAL BALANCE - DETAIL
Brenda's Bagels Inc. 1
Receivables Management

Ranges:
Customer ID: First - Last Customer Name: First - Last Sorted
Salesperson ID: First - Last User-Defined 1: First - Last
Class 1D: First - Last Sales Territory: First - Last
Document Date: First - Last

Customer: BETHS Name: Beth's Bath World Account Type: Open tem Ag
User-Defined 1 Salesperson: Credit: None
Contact: Territory:
Phone. (000) U000 EXE, OO0 Terms: 7% 10Net 20
Document Number Type Date Amount Discount Writeoff Current 0-30 Days. 31 - 60 Days
SALES000000000002 sLs 10/14/2015 $260.50 $260.50
‘SALES000000000004 SLs 10/1: $371.00 $371.00
Current 0-30 Days 31 - 60 Days
Totals: $631.50 $0.00 $0.00
Customer: JOES CATERNG Name: Joe's Catering Account Type: Open tem Ag
User-Defined 1: Salesperson: Credit: None
Contact: Joz Look Territory:
Phone: (000) 000-0000 Ext. 0000 3 2% 10/Net 20
Document Number Tvpe Date Amount Discount Writeoff Current 0-30 Days. 31- 60 Days
SALES000000000001 SLs 7/5/2015 $161.90 $161.90
Current 0-30 Days 31 - 60 Days
Totals: $161.90 $0.00 $0.00
Customer: PET PLANET Name: Pet Planet Grooming Account Type: Open tem Ag
User-Defined 1: Salesperson: Credit: None
Contact: Territory:
Phone: (000) 000-0000 Ext. 0000 2% 10/Net 20
Document Number Type Date Amount Discount Writeoff Current 0-30 Days. 31 - 60 Days
‘SALES000000000003 SLs 10/14/2015 $381.00 $381.00
Current 0-30 Days. 31 - 60 Days.
Totals: $381.00 $0.00 $0.00
c s: Current 0-30 Days 31-60 Days
Grand Totals: 3 $1,174.40 50.00 50.00
-
i v

Lab 4.3 Assignment Deliverable

LD

Lab 4

In the Word document that you created, take a screen shot of your screen output
and paste it into the document. Label it Lab 4.3. Make sure your user ID is in the

screen shot!
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Lab 4.4 Payroll

Lab 4.4.1 Enter Payroll

Brenda’s uses a payroll service, and this is the report that we will use to pay the
employees:

7/31/15 Payroll

Federal Social State
Taxes Security Medicare Taxes
Employee Name Gross Pay Withheld Tax Tax Withheld Net Pay
Brenda Phillips $8,333.33  $(1,036.46) $(516.67)  $(120.83)  $(377.00) $6,282.37
Lydia Knolls $6,250.00 $(653.13) $(387.50) $(90.63)  $(281.00) $4,837.75
Your Name $2,250.00 $(86.67) $(139.50) $(32.63) $(95.00) $1,896.21
Total $16,833.33 $(1,776.26) S$(1,043.67) $(244.08)  $(753.00) $13,016.32

Let’s enter the payroll journal entry. Click Transactions>Financial>General

. i Microsoft Dynamics GP =

\‘/‘\/' | Home » ["l £
4 Microsoft Dynamics GP ~ ‘ Transactions v| Inquiry ~ Reports + Cards ~

== Stude [ Geneat |

Sales Clearing

I v !
User Preferences N To

Shortcuts Reminde
Report Shortcuts

Purchasing Quick Journal

Payroll Batches

vy v v v v

Tasks .
Startup Fixed Assets Series Post
Custont Returns Management Bank Deposits
Check E:
< | N Bank Transactions

Miscellaneous Check
Bank Transfers

Reconcile Bank Statement

Transaction Matching

Transaction Matching Groups
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HX = &

Transaction Type:

Save Delete Void Post Correct Copy Paste View File Print Tools Help Add
Actiof View File Tools Help
Journal Entiy 1420 T Intercompany Batch ID | IPI')I

Transaction Date

73/2m5

Iﬁ Standard ¢ FleversingJ Reversing Date
Source Document GJ |P|

Reference 7431215 Payroll

Currency ID l/(_ f’r |Dl

Co.D [/ I [Account |7 | 9> Debit Credit @
Description @
Distribution Reference Corresp Co. ID i
BE1 000-1100-00 \ $0.00 $13.016.32 4
BE1 000 -5005-00 ‘ $16.833.33 $0.00
BE1 000-2270-00 \ $0.00 $1.043.67
BE1 000-2270-00 ‘ $0.00 $244.08
BE1 000-2275-00 ‘ $0.00 $1.776.26
BE1 000 -2280-00 ‘ $0.00 $753.00
BE1 000-5160-00 ‘ $1.043.67 $0.00
BE1 000-5160-00 ‘ $244.08 $0.00
BE1 000-2270-00 ‘ $0.00 $1.043.67
BB1 000-2270-00 \ $0.00 5244 U}
4
e
Thtal $18,121.08 $18,121.08
Difference $0.00
4 4 » »l [byBaichID - Status

Enter in as above and click Post.

Close the window and print or cancel.

Lab 4

37



Brenda’s Bagels

Let’s run a report on our cash account. Click Inquiry>Financial>Summary

Transactions ~ | Inquiry ~| Reports ~ Cards ~

4 Microsoft Dynamics GP ~

g:ustomizethis page’;

t1's Home System ’
Company >
lo . "
—
5
Sales >
s Over Credit Lim i
Purchasing 4
Customer Transa
Human Resources »
Fixed Assets »
- Experience Impr¢
Pavroll tax pdp Returns Management »
*Payro updat
Al
Yei
Check
Year-|
<]
& Links ﬂ M
‘osting Add R
y Inquiry
s Summary Inquiry
sles Summary Inquiry
s Actual Inquiry
ok Balance Inquiry
e Bank Statements
nsactions Pending Approval List

Detail

Analysis

Account Rollup

Journal Entry Inquiry
History Summary

History Detail

Budget Summary

Budget vs. Actual

Budget Journal Entry Inquiry
Budget Transaction Summary
Net Change

Checkbook Register
Checkbook Balance

Transaction Match by Link Number
Transaction Match by Account
Transaction Matching Groups

Cash Flow Calendar

Cash Flow Explorer

Let’s look’ at our cash account.

D osE=/ll @7
Clear  View File Print /' Tools Help Add
' ™ ¥ 2 ¥ Note
Actio... View File Tools Help
Account 000-1100-00 =5y
Description Cash-Checking ] Yearr |[EIE ~
Period Debit Credit Net Change Period Balance
Beginning Balance $0.00 $0.00 $0.00 $0.00 + |
Period 1 $0.00 $0.00 $0.00 $0.00
Period 2 $0.00 $0.00 $0.00 $0.00
Period 3 $0.00 $0.00 $0.00 $0.00
Period 4 $0.00 $0.00 $0.00 $0.00
Period 5 $0.00 $0.00 $0.00 $0.00
Period 6 $0.00 $0.00 $0.00 $0.00
Period 7 $25,000.00 $13.016.32 $11,983.68 $11,983.68
Period 8 $0.00 $0.00 $0.00 $11,983.68
Period 9 $0.00 $0.00 $0.00 $11,983.68
Period 10 $0.00 $0.00 $0.00 $11,983.68
Period 11 $0.00 $0.00 $0.00 $11,983.68
Period 12 $0.00 $0.00 $0.00 $11,983.68
~|
Totals $25,000.00 $13.016.32 $11,983.68 $11,983.68 |
Currency
MO b [byhocountType -

Lab 4
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Lab 4.4 Assignment Deliverable

In the Word document that you created, take a screen shot of your screen output
and paste it into the document. Label it Lab 4.4. Make sure your user ID is in the
screen shot!

Congratulations! This is the end of Lab 4!
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